Sauna™ Quick Tour #6: Exporting models to SPICE for
electrical-thermal co-simulation

About Sauna Quick Tours

The Sauna Quick Tours let you preview the features provided by the Sauna thermal modeling
program. You will create actual models, just like an experienced Sauna user. The documen-
tation explains all modeling steps, so no background with Sauna is required. However, as the
name implies, the Sauna Quick Tours are not detailed introductions to the software. Many
important topics are skipped over or discussed briefly. To become a skilled user, you need to
work the tutorial exercises found in the Sauna User Manuals. Many of these exercise are also
available to prospective users on the thermalsoftware.com website.

Overview

In this exercise you will create a Sauna model and export to the LTspice circuit simulation
program. The LTspice program is an industry standard and is available as a free download
(see "Downloading and installing LTspice" on page 9). You will start with a very simple
configuration in LTspice (see Figure 7 on page 9) and will finish with the circuit shown in
Figure 1. When an LTspice circuit includes a Sauna model, there are surprising insights about

circuit performance. Thermal changes everything.
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Figure 1: Co-simulation with Infineon CoolSiC MOSFET

If you are an electrical engineer, you have undoubtedly worked with circuit simulation soft-
ware before. So you shouldn't have any trouble working with LTspice. On the other hand, if
you're a mechanical engineer, this will be all new. But you shouldn't be concerned, there are
very detailed LTspice instructions for those that need it.

Thermal Solutions Inc., 3135 S. State St., Suite 350C, Ann Arbor Ml 48108 USA
www.thermalsoftware.com
Sauna is a trademark of Thermal Solutions Inc.



Thermal capacitance in a Sauna model

You will start by creating a simple 25 mm x 25 mm square plate model. Before beginning the
exercise, make sure that the error beep on your computer is turned on (not muted).

<F12 Root Menu> - Model = Assembly - Planar Plate = hit <Enter> to skip - Rectangle
-> Vertical XY = "25,25,1" (do not type the quotes) - (0,0,0)
- Iron/Steel = AISI 1010 = Paint/White

The planar plate will be created. You will see 4 nodes and 4 resistors inside thick dashed lines.
The dashed lines represent the boundaries of the assembly. (Planar plate assemblies have a
single plane of nodes and resistors, as opposed to bars and tubes, which can have multiple
node/resistor planes.)

Each of the 4 nodes has an associated thermal capacitance. By default, capacitance is not
shown. But it's easy to activate capacitance symbols:

<F6 Setup> - Display = Node - Capacitance = Show Symbol

Now the screen shows a capacitor symbol as well as the ground connection, as shown in
Figure 2. In thermal modeling, the network ground is the room ambient temperature.

capacitor symbol

Figure 2: Node capacitor symbol

You can also display capacitance values by selecting the third item on the menu:

Write Value

The screen now shows the capacitance of 0.56 W-sec/°C for each node, a useful feature. Return
to the default display mode:

Off



Now you need to complete the simple model. First, add a transistor:

<F12 Root Menu> - Model > Heat Input = Basic Source = "1" (do not type the quotes) > "S1"
- TO-247 - Typical > Standard > Greased - Plate/Board - One - click assembly edge
- Coords/Trap = "12,20"

A basic heat source will be created. With a basic heat source, it is assumed that all of the heat
leaves the package through the base (slug) of the component. The other type of heat source,
enhanced, allows for heat transfer through the base, leads and top. Enhanced heat sources are
primarily used with circuit boards, which is described in Sauna Quick Tour #2: Circuit Board
Modeling.

If you look at the screen, you will see that the heat source is connected to the plate with just one
case-to-sink resistor. For best accuracy, you should have at least 4 case-to-sink resistors. Sauna
has the align command, to quickly resize the plate mesh to match the size and location of the
heat source. Align the mesh with;

<F12 Root Menu> - Edit &> Assembly = Remesh/Alignh - Align - Heat Source - 4 Node Conn
= click on heat source - All In Wind - USE

The mesh will be realigned with a higher density. Next, add float resistors and an ambient
node:

<F12 Root Menu> = Model = Amb + Float = Isoltd->Fix » "Room Amb"
- Enter Later - Secondary - All In Wind - USE

The ambient node and float resistors will be created, but the screen is probably a bit confusing.
To better see the new ambient and resistors, you will switch to a right view.

For commonly used commands, there are a series of buttons at the lower-left of the Sauna

window. The third button in the second row is for switching to a right orthogonal view.
Change the view with:

click

The screen will be as shown in Figure 3:
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Figure 3: Ambient node and float resistors



Now that the heat flow path to ambient has been created, you can reduce screen clutter by
making these nodes and resistors invisible. There's a button for this:

click 1] >¢

Return to a front view:

click

Now calculate temperatures:

<F12 Root Menu> - Analyze - Calc Temps - Steady - Natural - "25"
The temperature calculation will complete quickly. When complete, you will see two temp-
eratures for the heat source. The upper temperature, 104.20°C, is the junction temperature.
The lower temperature, 103.60°C, is the case temperature (Tjunct = Tcase + q * Rjunct-to-case)-
When you calculate temperatures, values are assigned to all of the float resistors. This means
you are ready to export the model.
Exploring export options
Begin the export process:

<F12 Root Menu> - File = Export = Model = LTspice

You will reach the LTspice menu:

LTSPICE
1 Subcirc/Symb
2 Library
3 Netlist

There's three options. The simplest to use is "Subcirc/Symb", for "subcircuit/symbol”, and you
will start with this option. The "Library" option is also quite useful and you will use this later to
export a series of thermal designs. Finally, there is the "Netlist" option. This option is a bit
awkward to use but provides compatibility with just about any Spice software variant.

Continue with:
Subcirc/Symb

Now you reach the Ht Src Capac (heat source capacitance) menu:

HT SRC CAPAC
>1 Skip
2 Include

You are probably a bit perplexed by this menu, but it's actually pretty simple. Within Spice,
you will be connecting the Sauna thermal models to component models which already include
thermal capacitance. So while the Sauna model does include capacitance for heat sources, you
don’t want to double-count this information.



Finish with:
Skip = Screen

The exporting information will be displayed on the screen. Of course, you would normally
export to a file (actually two files), but for learning it's useful to see the export contents on the
screen.

The first screen shows the beginning of the subcircuit definition. The first non-comment line is
".subckt NEW_FILE S1_Tc room_amb". This line provides a name for the subcircuit, as well as
the connection points (pins in the Spice model). There are only two connection points, one for
the heat source and one for the ambient connection. You can certainly have more than one heat
source, in which case there would be additional connection points.

After the subcircuit header line, you will see the line "Rth1 N1 N5 2.1108E+1". This is the
definition for the first resistor. Sauna automatically creates unique labels for each resistor and
each node, as required by Spice and the resistance value is 2.1108E+1°C/W.

Click the Next button to advance to the next screen. Halfway down, there is a transition to the
capacitor definitions. Click Next again, and you will reach the end of the subcircuit definition
with the line “.ends NEW_FILE”.

Now click the Done button. There will be one more screen. This is the definition of the symbol
for the thermal circuit. When you place the thermal model in the Spice schematic, you won't
see any thermal nodes, resistors or capacitors. Instead you will see a simple symbol with
connection pins for each heat source and another for the ambient. See Figure 4 for an example:
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Figure 4: Thermal model symbol in LTspice

Click the Done button to clear the Info screen.

The current model doesn't represent anything that you're likely to export, thus it's not a good
test case. Delete the current model:

<F12 Root Menu> - Delete = Everything = click Yes button



A better heat sink model (create or load)

For the first actual export to LTspice, you will create, or load, the heat sink shown in Figure 5.
This simple heat sink is created in the first introductory exercise in the Sauna User Manual. If
you have some experience with Sauna, or have already worked one of the quick tours, you can

simply load the model. The model is found in the “C:\Program Files (x86)\Sauna Thermal
Modeling\Reference Models” folder.

40W power transistor, 25
l TO-247 package,
(20,60,0)

material: extruded aluminum
fin surface: white paint

80 mm (3.1")

200 mm (7.9")

\

Figure 5: Basic heat sink model
If you choose to load the model, do it now:
<F12 Root Menu> - File = Open

- navigate to C:\Program Files (x86)\Sauna Thermal Modeling\Reference Models
- select new_sink.smf - click Open button

click

You should see Tsi-junct = 136.98°C. Skip the next section and proceed to "Modifying and
exporting the heat sink model".

Detailed instructions for creating the heat sink

If you are completely new to Sauna and are starting with this quick tour, it's instructive to

create the heat sink model yourself. It doesn't take long. Begin by creating a planar plate
assembly:

<F12 Root Menu> - Model > Assembly = Planar Plate = "Sink" - Rectangle - Vertical XY
- "200,80,5" = (0,0,0) = Aluminum = Extruded - Paint/White

The assembly will be created.



Next, switch to a perspective view and add fins on the back (secondary) side of the plate:

click

<F12 Root Menu> = Edit = Assembly = PIt/Bar Prop = New Fins = “25,10,2”
- Secondary = All In Wind > USE

Additional dashed lines will be drawn to show the boundaries of the fins. If you want to see
each individual fin, switch to shade mode:

click

The model will be as shown in Figure 6:

Figure 6: Plate with fins in shade mode

Turn off shade mode and switch to a front view:

click > click
Now add the basic heat source:

<F12 Root Menu> - Model - Heat Input - Basic Source = "40" > "S1" - TO-247 - Typical
- Standard - Greased - Plate/Board = One = click edge of plate > Coords/Trap = “20,60”

As before, align the mesh:

<F12 Root Menu> - Edit > Assembly > Remesh/Align = Align = Heat Source
- 4 Node Conn = click on red heat source node - All In Wind > USE

The node and resistor mesh will be recreated, and the heat source will be connected with 4 case-
to-sink resistors. (Please note: if you make a mistake, use <F12 Root Menu> = Edit = Undo and
try again.)

Create the fixed node and float resistors:

<F12 Root Menu> - Model &> Amb + Float - Isoltd->Fix & "Room Amb"
- Enter Later > Secondary - All In Wind > USE

The fixed node and float resistors will be created.



Turn off the float resistors and ambient node:
click 1] >¢

In a moment, you will calculate temperatures. However, before this, it's worthwhile to see a
report for the finned plate assembly:

<F7 Info> > Trap > Any Assy - click edge of plate
A comprehensive listing of the plate characteristics will be displayed. If you advance to the
second page, you will see details on the convection and radiation parameters. The Info reports
are an important tool for verifying that the model was created correctly.
After clearing the report from the screen, calculate temperatures with natural cooling:

<F12 Root Menu> - Analyze - Calc Temps - Steady - Natural > "25"

You should obtain Tsi-junct = 136.98°C.

Modifying and exporting the heat sink model

You will modify the heat sink to match the Infineon MOSFET shown in Figure 1. The Rjc for
this device is 0.31°C/W, which is different from the default value of 0.60°C/W. Make the
change:

<F12 Root Menu> - Edit > Heat Input - Basic Source = R_junct_case
-> click on heat source - Specify > ".31"

Also, change the wattage to 36.5W, which is the device dissipation in the Figure 1 circuit:
Wattage = "36.5" = All In Wind = USE
Now recalculate temperatures:
<F12 Root Menu> = Analyze - Calc Temps = Steady - Natural > "25"

With this change, Tsi-junct = 117.52°C and Tsi-case = 106.21°C. Next, you will save the model as
"spice_test.smf". Be sure to save the model in an appropriate folder (not the Reference Models
folder). Save the model now:

<F12 Root Menu> - File > Save As - type "spice_test" in file name box -> click Save button

Now you are ready to export:

<F12 Root Menu> - File = Export - Model = LTspice = Subcirc/Symb -> Skip - File
-> click Save button

Sauna will create two files, the subcircuit file (.subckt) and the symbol file (.asy). You will see:

Successfully wrote "spice_test.subckt"
Successfully wrote "spice_test.asy"

You're ready to create a first schematic in LTspice.



Downloading and installing LTspice
To continue, you need LTspice installed on your computer. As of February 2026, the link is:
https.//www.analog.com/en/resources/design-tools-and-calculators/LTspice-simulator.html
Alternatively, you can obtain the link by googling "download LTspice". As mentioned earlier,
it's a free download and Analog Devices doesn't try to sell you anything or bother you with
annoying emails. After downloading, the installation process is very similar to other programs.
Possibly, for one reason or another, you don't want to install LTspice. If this is you, you will
have to stop here. Nonetheless, you have already gained insight about exporting from Sauna.
Before moving on to something else, it is recommended that you spend a minute or two
scanning the remaining pages of the exercise.

Building a simple schematic in LTspice

You will start by creating the very simple schematic shown in Figure 7. With this circuit, you
will be able to verify that LTspice and Sauna produce the same result.

I1
/\ T _case
T
36.5
S1 . Tc
Sauna Thermal Model
spice_test.smf
" room__amb
i vi
@
25
e

Figure 7: First LTspice schematic

Start up LTspice. You can leave Sauna open with the spice_test model (minimize to the Taskbar
if you wish). Begin with:

File > New Schematic

In a moment, you will place the symbol for the Sauna subcircuit. But you need to make sure
that the symbol is in the search path. Click the Gear icon at the upper left, then click the Search Paths
tab. The dialog box shows the default path and any additional paths in Symbol Search Paths.
You will probably want to add a new path so that LTspice can find your Sauna subcircuit.

If you are an experienced LTspice user, just go ahead and create the circuit shown in Figure 7.
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Figure 8: Icons used to create schematic

If you are new to LTspice, or just out of practice, the checklist below will guide you. Figure 8
show the icons that you will be using. Create the schematic now:

1. Click the Component icon (see Figure 8), then select spice_test on the list (scroll to the
right). Click the Place button, then position the symbol at the center of the screen and click.
Hit <Esc> or right-click to stop placing additional copies.

2. Use the scroll wheel on your mouse to zoom out. To re-center the screen, hold down the
left mouse button and drag.

3. Click the Voltage Source icon. Then position the voltage source directly below the Sauna
symbol and click. Hit <Esc> or right-click to stop placing.

4. Right-click the voltage source and type in 25 for the DC value, then click the OK button.
For LTspice, temperature is represented as a voltage.

5. Click the Component icon again. Scroll to the left and select current, then click the Place
button. Prior to final placement, use <Ctrl>-r to rotate the current source. Then move to
the position shown in Figure 7 and click. Hit <Esc> or right-click to stop placement. For
LTspice, wattage is represented as an electrical current.

6. Right-click the current source and type in 36.5 for DC value, then click the OK button.

7. Figure 7 shows 2 grounds. Click the Ground icon and place the grounds in the
appropriate position. When finished, hit <Esc> or right-click.

8. Now that components and grounds are in place, you need to add wires. Click the Wire
icon. Then click on the appropriate pins and create the wires. By default, LTspice draws
on the grid. (For a diagonal connection, depress the <Ctrl> key while drawing between two
pins.) When finished, hit <Esc> or right-click.
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9. Notice that the wire above the Sauna model is labeled with "T_case". This is a net label.
Click the Label Net icon. In the dialog box, type in T_case and click OK. Then click the wire
to the right of the current source. When finished, hit <Esc> or right-click.

10. Finally, note that the letters ".op" are shown in the lower-left of Figure 7. This is known
officially as a Spice directive but is generally referred to as a dot command (much easier to
say). The .op command tells LTspice to perform a DC analysis (operating point), the
equivalent of a steady state thermal analysis. Click the dot command icon and enter .op in
the box, then click OK. Place the command in the appropriate location.

This is a good time to save the schematic. Use the name "spice_test_simple":

File > Save As - “spice_test_simple”—> click Save button

Running the first Spice simulation

Now you're ready to simulate. You just need to click the green run icon shown in Figure 9.

E;T LTspice - [spice_test_nat.asc]
i; File Edit Hierarchy View Simulate Tools Windo

cacheedrels

runicon

Figure 9: Run icon

Click [» now.

The simulation will be complete in about 1 second. A text window will pop open with the
operating point (steady state) results. Remember that voltage is analagous with temperature. So
the window shows V(n001) of 25, which is the ambient temperature. V(t_case) is 106.209, which
exactly matches the case temperature (106.21°C) in the Sauna model. So everything is as
expected.

Clear the Operating Point window before continuing.

Performing a transient analysis
Follow these steps to run a transient analysis of one hour (see Figure 10):

1. Click the delete icon. Then click on the .op command to delete. Right-click or hit <Esc>
to stop.

11



2. Add a transient analysis dot command by clicking the Spice Directive icon and entering
“.tran 3600s”(no quotes) in the box. Then click the OK button and place in an appropriate

location.

3. There’s one last step. You need to tell LTspice to start the heat sink at 25C. You will do
this with an initial condition of 25 for V(T_case). As you have done before, define the
“.ic V(T_case)=25" dot command shown in Figure 10.

T case

S1,

' Tc

Sauna Thermal Model

spice_test.smf

room,

&

Figure 10: Model setup for transient analysis

Now you are ready to run the analysis:

click D

The simulation completes quite quickly, only about one second. A blank second window,
identified as spice_test_simple.raw, will open above the schematic. This is the results window

and you will plot results here.

It’s very easy to plot results, position the mouse cursor on the T_case wire, then click. The transient
curve for T_case will be as shown in Figure 11 on the next page:

12
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Figure 11: transient case temperature

The curve is largely identical to the curve you would obtain with Sauna. Note that transient
results will never be exactly the same because of differences in the transient analysis algorithms.
Also, Sauna adjusts the thermal resistance to ambient throughout the analysis while LTspice is
working with a constant resistance obtained at the final steady state conditions. But these are
generally small discrepancies (see "Assumptions and limitations" at the end of the quick tour).

Before starting the next section, return to steady state analysis. This is easy to do with the Undo
command. Just hit the Undo icon, located at the upper right of the screen, three times. Besides

the Undo icon, you can use <Ctrl-z> or Edit = Undo. When complete, the .op commend should

be visible. Finally, close the results window and expand the schematic window.

Performing a forced air cooling analysis in Sauna

The first analysis was done with natural cooling for the heat sink, now you will try simulating
with an air flow of 500 ft/min.

Return to the spice_test model in Sauna. You should leave LTspice open (minimize to the Taskbar
if you wish).

Analyze the heat sink with 500 ft/min cooling:
<F12 Root Menu> - Analyze - Calc Temps - Steady - Forced Air - Feet/Minute - “500” - "25"
You should obtain Tsi-junct = 83.70°C and Tsi1-case = 72.38°C.

With forced air cooling, the resistance between the heat sink and the ambient will be reduced.
So you need to re-export the Spice model to incorporate the resistance change.

13



As before, export the model:
<F12 Root Menu> - File & Export = Model = LTspice = Subcirc/Symb - Skip - File
- click Save button = click Yes to overwrite spice_test.subckt
-> click Yes to overwrite spice_test.asy

Sauna will indicate that spice_test.subckt and spice_test.asy were successfully written.

Updating the model in LTspice
Return to LTspice. You should leave Sauna open (minimize if you wish).

As it turns out, there’s nothing to update, just run the analysis:

click >

The operating point window will open and you will see V(t_case) = 72.3841, the same
temperature as Sauna.

While it’s really easy to switch between Sauna and LTspice, you should be aware of the signif-
icant potential for confusion. If you want to evaluate a series of thermal models, it's better to
use a library.

Clear the Operating Point window before continuing.

Creating a thermal model library
Return to Sauna.

Up until now, you have exported with the "Subcirc/Symb" option. This is the quick and easy
option. But "quick and easy" can lead to "I'm confused" when you want to evaluate a series of
thermal designs, since LTspice always automatically loads the latest subcircuit iteration without
changing the symbol or notifying the user. And the confusion will be worse if the thermal
modeler and LTspice user are not the same person.

To keep everything organized, there are strong advantages to exporting with a library. So in
this section you will be creating a simple library for the spice_test heat sink. The library will
contain 4 thermal models: natural cooling, 500 ft/min cooling, 1000 ft/min cooling and an
improved natural sink design.

At the moment, the model shows Tsi-junct = 83.70°C, the result for 500 ft/min cooling. The first
subcircuit in the library will be natural cooling, so start by running a natural cooling analysis:

<F12 Root Menu> = Analyze - Calc Temps = Steady - Natural > "25"

As before, you should obtain Tsi-junct = 117.52°C.

14



Begin creating the library:
<F12 Root Menu> - File = Export - Model = LTspice = Library

You will reach the Lib Export (library export) menu:

LIB EXPORT
1 New + Symb
2 Append

You will start with "New + Symb" which creates a library containing one subcircuit, along with
an associated symbol. The first subcircuit will be natural cooling. After creating the library,
you will use "Append" to add additional subcircuits. Finish creating the library with:

New + Symb - Skip = File = enter "lib_spice_test" in File name box > click Save
- "nat_cooling"

Sauna will indicate that you successfully wrote "lib_spice_test.lib" and "lib_spice_test.asy".

The library has now been created. At the moment, there is one subcircuit with the identifier
"nat_cooling". The next step is to add a second subcircuit for 500 ft/min cooling.

Recalculate temperatures with 500 ft/min (fpm) cooling:

<F12 Root Menu> = Analyze - Calc Temps - Steady - Forced Air
- Feet/Minute - “500” - "25"

As before, you should obtain Tsi-junct = 83.70°C and Ts1-case = 72.38°C. Now that the thermal
resistance to ambient has been updated, append the results to the library:

<F12 Root Menu> = File = Export = Model = LTspice = Library = Append - Skip = File
- select "lib_spice_test.lib" - click Save - "forced_500_fpm"

Sauna will indicate that "successfully appended to lib_spice_test.lib".
Now obtain results for 1,000 ft/minute cooling:

<F12 Root Menu> - Analyze - Calc Temps - Steady - Forced Air
- Feet/Minute - “1000” - "25"

You should obtain Tsi-junct = 74.66°C and Tsi-case = 63.35°C. Once again, append the results to
the library:

<F12 Root Menu> - File = Export - Model - LTspice - Library > Append - Skip = File
- select "lib_spice_test.lib" > click Save - "forced_1000_fpm"

As you have just seen, forced air cooling is effective for reducing the device and sink
temperatures. But fans also have disadvantages, such as added cost, reduced reliability and
possibly filter clogging. So it's always better if a natural cooling solution can be found.

As it turns out, the current sink design is not optimal. First, the heat load is concentrated in a

corner of the sink. Also, the backplane thickness, fin length and spacing could be modified to
reduce temperatures.
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Let's try some what-if sink modifications to see if we can obtain temperatures which match the
500 ft/min results, while still using natural cooling. First, shift the heat load to the center of the
sink:

<F12 Root Menu> - Edit - Heat Input - Basic Source - Shift > click on heat source
- Same - Coords/Trap = "100,40"

Realign to the heat source:

<F12 Root Menu> - Edit > Assembly = Remesh/Align = Align - Heat Source - 4 Node Conn
- click on heat source > All In Wind > USE

Now calculate temperatures with natural cooling:
<F12 Root Menu> = Analyze - Calc Temps -> Steady - Natural - "25"

Now Tsi-junct = 103.22°C and Tsi-case = 91.91°C, a nice improvement of 14°C. However, the heat
source is still warmer than the forced air configuration.

Next, try increasing the fin length to 50 mm:

click

<F12 Root Menu> = Edit & Assembly = PIt/Bar Prop = Fin Props = Length
= "50" = Secondary = All In Wind - USE

Recalculate temperatures:
<F12 Root Menu> = Analyze - Calc Temps = Steady - Natural > "25"

With this change, Tsi-junct = 88.32°C, a further reduction of 15°C. But the temperature is still
hotter than the 500 ft/min results. Increase the backplane thickness to 8 mm:

<F12 Root Menu> - Edit &> Assembly - Dimensions - Plate Thick - Enter Value -> "8"
- Centerline = All In Wind - USE

Recalculate temperatures:
<F12 Root Menu> - Analyze - Calc Temps - Steady - Natural = "25"

With the thicker backplane Tsi-junct = 83.82°C. This is within 0.1°C of the 500 ft/min result, so
the goal has been achieved.

Export this model to LTspice:

<F12 Root Menu> - File = Export > Model = LTspice - Library = Append = Skip = File
- select "lib_spice_test.lib" = click Save = "nat_improved"

If further natural cooling improvements are needed, the backplane thickness could be increased
further. Another option is to use thinner fins and some small gains could be achieved by
optimizing the fin spacing.

There will be no further modification to the Sauna model. Exit Sauna without saving:

<F12 Root Menu> = File = Exit & click No button
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Using a Sauna library with LTspice

Return to LTspice.

You will modify the circuit to obtain Figure 12. There isn't much to do, just delete the existing
Sauna model block and replace with the library block ("lib_spice_test”). Then add the library
dot command.

T_case

(Lx

w
o
n

s1/Tc

Sauna Thermal Library

nat_cooling
C:\wk2\lib_spice_test.lib

.lib lib_spice_test.lib

room_amb

0B Vi

o

25

N7

Figure 12: LTspice schematic with Sauna library
If you're an experienced LTspice user, make the changes now..
If you want detailed steps, follow this checklist:

1. Select the Delete icon. Then click on the Sauna model to delete. Hit <Esc> or right-click
to end.

2. Click on the Component icon. Find lib_spice_test in the list and select it. (If you don't
see lib_spice_test, hit the Refresh button below the list.) Then click the Place button. Move
the symbol to the appropriate position and click. Hit <Esc> or right-click to end. If the
Sauna library symbol is placed in exactly the same position as the previous Sauna model,
the wires will be connected automatically.

3. Select the dot command icon. Type ".lib lib_spice_test.lib" in the box, then click OK.
Move the dot command to the appropriate location and click.

This is a good time to save the model:

File > Save As - “spice_test_with_library”-> click Save button
The model is now ready to run. But first, there's some things to point out. First, notice that the
name of the Sauna block has changed to "Sauna Thermal Library", which is not surprising. But,
more importantly, the center of the block shows "nat_cooling". This is the first subcircuit and

also the active subcircuit. So the first analysis will be for natural cooling. Later, when you
switch the cooling mode, the block text will automatically update.
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Run the model:

click |>
The operating point window will open and you will see V(t_case) = 106.209, which matches the
natural cooling result from Sauna. Close the Operating Point window before continuing.
Switching subcircuits
It is exceptionally easy to switch to a different thermal subcircuit. Follow these steps:
1. Right-click on "nat_cooling" in the Sauna block.

2. A window with the title "Enter new value for U1" will open. Enter "forced 500 fpm" and
click OK.

That's it, you have switched to 500 feet/minute cooling. Notice that the center of the Sauna block
has been updated to show the new subcircuit.

Once again, run the model:

click >

With the new cooling mode, you will obtain V(t_case) = 72.3841, once again matching the Sauna
result. Clear the Operating Point window before continuing.

For the moment, you are done with the Sauna library. You only used 2 of the 4 subcircuits, but
you will make use of the remaining subcircuits with the Infineon MOSFET circuit shown on the
next page.

Close the schematic without saving:

File > Close = click No button

Real world circuit with Infineon MOSFET
Now you will simulate the circuit shown in Figure 13 on the next page.

If you examine Figure 13, and assuming you know something about MOSFET's, you can
deduce that the MOSFET is in the "on" state. In this situation, the dissipation is determined by
the current, voltage and Rds-on. The V3 and R7 were chosen to obtain a nominal Pgiss 0of 36.5W,
which is what you have been using in the Sauna model. So, once again, you will have an
opportunity to compare results between LTspice and Sauna.
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Figure 13: Co-simulation with Infineon CoolSiC MOSFET

room__amb

If you are a frequent LTspice user, it will only take a few minutes to create the circuit. But you
also have the option of loading "sauna_mosfet_infin.asc" from Sauna's reference models folder.

However, the first step is to download the necessary Spice library from Infineon. It's not
appropriate for Thermal Solutions to provide the library, so go to the webpage for the MOSFET:

https://www.infineon.com/part/IMW120R020M1H#design-resources

On the page, select "Simulation models". Then download "CoolSiC 1200V Genl Trench
MOSFET SPICE model"”, which is a zip file. After unzipping, you will obtain several libraries
for CoolSiC parts. You will be using "IMW-IMZA120RXXXM1H_7-40mOhm_v1.4.lib" (sorry
about the long file name). Place this library in a folder in the LTspice search path.

The Infineon library can be opened with any text editor. Open the library file. The top of the file
shows the supported parts. If you scroll down, all of the subcircuits can be viewed. This is not
always the case, many library files are binary and can't be viewed. Exit the library file.

However, there is a disadvantage with the Infineon library. Infineon does not provide a symbol
(.asy) file. So you need to go to C:\Program Files(x86)\Sauna Thermal Modeling\Reference
Models”folder and copy infineon_mosfet.asy to your working folder.

Return to LTspice.

As stated above, you can create the Figure 13 circuit on your own or you can simply open

sauna_mosfet_infin.asc from C:\Program Files(x86)\Sauna Thermal Modeling\Reference
Models. Load or build the schematic now.
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Now you're ready to run the simulation:

click D

The simulation will complete successfully and the results window will open. Generate plots of
Tcase and Tjunction by clicking the T_case and T_junct wires. You should obtain Figure 14:

4 sauna_mosfet infin2.asc BEER

Figure 14: graph of V(t_case) and V(t_junct)

But there's something wrong. The graph shows V(t_junct) = 152 and T(t_case) = 136, much
hotter than the Sauna model, which has Ts1-junct = 117.52°C and Tsi-case = 106.21°C. What's
going on?

You can find the answer by plotting wattage. Depress the <Alt> key and hold the cursor over the

T _case wire until you see the ammeter icon, then click. The current (= wattage) will be displayed
with the scale on the right. Examination of the plot shows that while the wattage started at
roughly 35W, the final wattage is 50W. This is a very significant 37% jump from the assumed
36.5W. The wattage increase is a consequence of the temperature coefficient of Rds-on, where the
resistance increases with temperature.

If you were to go back to Sauna (not required) and increase the wattage to 50W, you would
obtain Tsi-junct = 147.48°C, close to the LTspice value. (The Sauna temperature is lower because
the increased wattage reduces the thermal resistance to ambient.)

Other than the wattage discrepancy, the graph reveals another serious problem with the
thermal design. If you examine the curves, you can see that both wattage and temperature are
still increasing after one hour. In other words, the configuration is very close to a thermal
runaway condition. So better heatsinking is required!
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Let's see how the circuit performs with the other cooling configurations in the Sauna library,
starting with 500 ft/min. Follow these steps:

1. Zoom in on the Sauna block.
2. Right-click on "nat_cooling" in the Sauna block.
3. Enter "forced_500_fpm" and click OK.

Run the simulation again:

click D

With the new cooling mode, V(t_junct) = 86, much closer to the Tsi-junct = 83.70°C in the Sauna
model. This is easy to explain, the plot shows that the wattage has decreased to 38W, close to
the 36.5W assumed in the Sauna model.
Finally, switch to 1,000 ft/min:

1. Right-click on "forced 500 fpm" in the Sauna block.

2. Change the value to "forced_1000_fpm" and click OK.
Run the simulation:

click >

Now V(t_junct) = 74.5, quite close to Tsi-junct = 74.66°C in the Sauna model. The LTspice
wattage is almost exactly 36.5W, so the Spice/Sauna correlation should be very close, and it is.
Note that V/(t_case) = 63.5 (used in the next section).
Checking Rjc
In the Sauna model, you used Rjunction-to-case (Rjc) = 0.31°C/W. This is the typical value shown
on the Infineon datasheet. It's interesting to compare this value with the results from the
current analysis. The analysis just performed shows:

ch = (Tjunction - Tcase) / wattage = (745 - 635) /36.5=0.30°C/W
So there is good agreement between the Spice model and the datasheet. But it's a good idea to
verify this. The person in charge of the datasheet is probably not the same person creating the
Spice model, so there is the potential for errors.

Evaluating the improved heat sink

There's still an additional model in the Sauna library. Switch to the improved natural sink
model:

1. Right-click on "forced_1000_fpm" in the Sauna block.

2. Change the value to "nat_improved" and click OK.
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Run the simulation:

click D

With the improved heat sink, Tsi-junct = 86 and Q = 38W. These results largely match the results
for the forced cooling analysis with 500 ft/min. Thus an acceptable natural cooling alternative
has been found. The time constant of the improved heat sink is larger (thicker backplane and
longer fins), so it takes longer for temperatures to stabilize. As mentioned earlier, there are
other options if you need to further improve the heat sink performance.

Component spacing and thermal coupling

Co-simulation is very useful for assessing different device positions. The current example is
very simple because there is only one heat generator, but for real circuits it is quite common to
have multiple devices in close proximity. In this case, the heat from one component can
strongly impact an adjacent component, this is known as thermal coupling. With Sauna/Spice
co-simulation, you can accurately assess thermal coupling effects and quickly evaluate different
component spacings.

This completes the exercise. Delete the schematic without saving:

File = Close = click No button

Co-simulation vs. the old way

You have just seen how the heat sink and circuit are interrelated. If you use a better heat sink,
the Pdiss decreases. And, of course, other electrical parameter are affected by temperature as
well. All of these important insights are unlocked when you use electrical/thermal
co-simulation.

This, of course, is very different from the old way of handling thermal issues. The old way is
top-down and there is no feedback. Specifically, the analysis starts with a worst-case (probably
very crude) estimate of power dissipation. And then an engineer attempts to define a cooling
system based on the worst case estimate. There is no consideration that the power dissipation
and cooling method are actually intertwined.

And in a conventional design environment, thermal modeling is only used for a worst-case
survivability analysis. There is no consideration of how operating temperatures are impacting
circuit performance and stability on a continuing basis. Use co-simulation to take circuit
modeling and design to the next level. Thermal changes everything.

So much more is possible

The example that you just worked is very simple. As mentioned above, you are not limited to a
single heat source, there's no hard limit. With LTspice you can simulate for a variety of
conditions: cold start, duty cycle operation, voltage pulses and more. And results will be so
much more meaningful than with classic circuit analysis methods like simple temperature
sweeps.
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As far as the Sauna thermal model goes, you worked with a simple heat sink. In fact, it's the
very first model created when learning Sauna. It's something that any engineer, electrical or
mechanical, can learn how to do in just an hour or two. Yet this model is still quite useful and
can be the basis for sophisticated co-simulation.

And, of course, you can do much more with Sauna: complex multiplane heat sinks, multilayer
boards and complete boxes. For those willing to invest some time learning the tool (a day or
two), all sorts of complex configurations can be analyzed.

Assumptions and limitations
Co-simulation is amazing. But there are some things to be aware of.

Linearity and non-linearity. The resistors and capacitors that you export to SPICE are assumed
to be constants. For the resistors and capacitors for ordinary solid materials (aluminum, steel,
plastic, FR4) this is a pretty good assumption. Silicon is a notable exception, but this should be
handled through the component model in SPICE.

For cooling through air, the resistors are not constants and have some dependence on the AT
between a surface and the room ambient. But the temperature dependence is fairly modest.

For example, for natural convection in air, the thermal resistance decreases by about 15% with a
doubling of the ATsurface-to-ambient. Thermal radiation thermal resistance also decreases with a
doubling of the AT, with a 12% reduction. On the other hand, for forced air cooling there is
little dependence (< 1% for a doubling of the AT).

The ambient temperature also impacts thermal resistances. With a change from 25C to 60C
ambient, the natural convection resistance increases by roughly 4% while the thermal radiation
resistance decreases by about 25%. Forced air cooling resistances are little impacted by a
change in the ambient temperature.

Overall, the assumption of linearity is reasonable, within limits. For major changes in power
dissipation and ambient range, it's a good idea to re-calculate and re-export the Sauna model.

Work with time average power. Since the thermal model is sensitive to the ATsurface-to-ambient,
export the resistances which corresponds to the time average power. In the 36.5W example

above, if the duty cycle was 25% power on, you should adjust the heat source to 9.125W prior to
exporting.

There are another five Sauna Quick Tours. See the following pages for a preview.
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Sauna Quick Tour #1: Heat Sinks, Duty Cycles And Stackup Models
In the first Sauna Quick Tour, you will model these configurations:

fins: 25 long, 10 centerline, 2 thick

TO-220 package, 30W,
Ric = 1.3'C/W, greased interface

Heat sink with standard device

silicon

10x10x

chip, = 30W,
0.5

die attach
interface

copper flange,
25x25x0.5

Time

Duty cycle transient

Heat sink with custom stackups

Sauna Quick Tour #2: Circuit Board Modeling

In the second Sauna Quick Tour, you will see how Sauna can be used for both quick models
and detailed studies of circuit boards:

—_— .

DPAK package power
device, Q=1W,
X=40, Y=31.5

single layer
«—— FR4 board,
traces are 1 02. copper
24 | ||« 0.5 mm wide

Simple DPAK device model

SOIC-16 device

SOIC-16 device

two internal planes,
1 ounce copper

thermal vias

\ DPAK device,

A
2% high via density under

) device (100 vias/in2)
25 *
v

10

i
What-if #1: What-if #2: What-if #3:
Shorter Traces 25 x 25 Pad

Four Layer Board

DPAK device what-ifs

QFP device with
8 x 8 heat slug,
thermal vias

Four layer board with multiple components
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Sauna Quick Tour #3: Basic Finned Box, Box With Board

With Sauna you can do a quick analysis of a box, or you can model in great detail (including
internal convection and gray radiation analysis with automatic view factor calculation). These
boxes are modeled:

D2PAK package,

TO-218 package, 15W, 2 W, solder interface,

greased interface, Four layer board, 140 x 140, .
Ric = 0.6°C/W (typ. value) FR4, 1 oz. plating, (120,11.6,-120), typ. Ric
top/bott layers: 10% copper,
fins: 20 long, 10 centerline, 2 thick internal layers: full plane

box is zinc alloy 903,
4 mm wall thickness,
white paint surface,
top cover not shown

14 x 14 LQFP, 2 watts,

100 leads, no heat slug,
Rja = 32°C/W on 4 lyr brd,
(40,11.6,-40)

}\‘ X dimensions in mm 5 watts distributed
z over 60 mm x 80 mm

Basic finned box Box with internal board

Sauna Quick Tour #4: Modeling LED Boards

You can model boards with both low power and high power LED's. Sauna's library includes 40
standard LED packages, covering a wide range of automotive, industrial and consumer lighting
applications (user-defined packages are also allowed). It's easy to experiment with different
pad sizes, add or remove internal copper planes, test different via densities and simulate boards
which are bonded to heat sinks.

wire bond aluminum heat sink

die \‘
anzzer\%/ epoxy body /\ //\ //\ M H M R\ N‘ epoxy
interface

PLCC package

die

OSLON
Square LED

4 ceramic body

anode i
thermal pad ) cathode
Il

Multilayer board with high
ceramic package power LED, heat sink
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Sauna Quick Tour #5: Tubes and Cold Plates

Sauna is not just for air cooling. You can also easily handle liquid cooling with water, anti-
freeze mixtures, and more. In the fifth Sauna Quick Tour, you will start with a simple tube
model. Then you will model a full cold plate, including heat sources.

water out

25 x 25 power module,
Q=100 W, Rjc =0.1"C/W,
6061 auminum  100W heat load Roe = 0.05°GY
at top center

16 diam
/ Outer Diam = 16 mm
Inner Diam = 14 mm 74
T Center = (12,12) //
"//\/

water cooling,

1 gallon/minute
~

Tubes and cold plates with liquid cooling

aluminum,

Wrapping up and disclaimers

Thank you for working through Sauna Quick Tour #6. We hope you will work through the other
Sauna Quick Tours.

Remember that the Sauna Quick Tours only provide an overview of Sauna's capabilities.
Important details have been omitted. If you want to create accurate Sauna models, you must
work through the Introductory Exercises in the Sauna User Manuals. Many of these exercises
are also available online to prospective users (www.thermalsoftware.com/eval_exercises.htm).
You can even work through the exercises with the Sauna Evaluation Package.

If you have questions, be sure to contact Technical Support (support@thermalsoftware.com,

734-761-1956). Please note that transient and duty cycle analysis is only available with the
advanced version of the software: Sauna Modeling System. ¢
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